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1. Store Locator Configuration

Once you are finished with installing the extension it is time to proceed to your
Magento 2 backend to finalize the Store Locator setup.

Before creating your first store we suggest running through the Store Locator
extension settings and other options available to adjust the Store. This will help in
better understanding of how the extension functions and what can you expect your
stores to look and feel like.
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1.1. Accessing the Extension Main Settings

Stores Q A XL admnv

Settings Attributes
Reload Data

All stores Product
Configuration Attribute Set Hisabled. To enable the chart, click here.

Terms and Conditions Rating Tax Shipping Quantity

Order Status

To access the configuration settings for this extension, please go to

Taxes Stores > Configuration > Ulmod Extensions > Store Locator
Tax Rules .
Quantity
Tax Zones and Rates - . . 4
_._1
2

Currency

Currency Rates
\Weather Tank-L-Gray

Currency Symbols
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1.1. Accessing the Extension Main Settings

Configuration Q A X muemo-~

From here, you can manage all the main extension settings.
Just select the tab you want to configure, and tweak its features

Store View:  Default Config v (7] as you need. Save Config

GEMERAL e General @
CATALOG N )
Service APl and Comments ~
CUSTOMERS N
Store Search ®)
SALES N
SERVICES N
ULMOD EXTENSIONS ~

Store Locator
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1.2. General

General =)

Set the Enable option to ‘Yes’ to

% enable the extension in frontend _ . oo |
[ . pres with your proaucts Dy displaying them o
== or to ‘No’ to disable the > HEYeRTe e

bd.com. Set the Display Top Link option to ‘Yes’ to
display store locator link in top links of the
page or to ‘No’ to disable this functionality

extension.

Enable | Yes v
Enable/Disable extension in frontend Choose the List Store by :
e ‘Default’ to list store based on Sort
Display Top Link | Yes v Order of each.

Page title — Specify the title of e ‘Distance’ to list store based on the
the store list page and Store List Storesby | Default - distances between customers' location &
view (dEtaII ) pages. Default - Based on Sort Order of each store. stores. |f customers don't enter their

Distance - Based on the distances between customers' location & . . .

R . . stores. If customers don't enter their location, stores will be listed by Iocat|0n, stores will be listed by Default

Display holidays and special Default (Sort Order).

(Sort Order)

Alphabetical order - Based on alphabetical order of store name.

days in the next — Specify the
day(s) store's holidays and
special days will be shown in
frontend.

e ‘Alphabetical order’ to list store based
on alphabetical order of store name.

Page title | Store Locator

Title of the Store List page and 5tore Details pages.

Display holidays and special days in the next | &0

List Store Page Size — Specify the
number of store to display per
page on list page

day(s). Store’s holidays and special days within this period will be shown
n frontend.

List Store Page Size |10

Limit the number of stores will be show in list store when paging at

frontend. Image gallery — Specify the max
number of image to upload for
Image gallery |30 each store.

Limit the number of image for each store when uploading image.
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_onfiguration

CATALOG
CUSTOMERS
SALES

SERVICES

ULMOD EXTENSIONS

Store Locator

lmod

1.3. Service APl and Comments

Google Map API key — Specify your Google Map API key. Follow this to Get your API
key.

Choose the Allow Comment :
* ‘No, Do not Allow Comment’ to disable this comment functionality on store view page.

¢ ‘Yes, Allow Facebook Comments’ to enable facebook comment on store view page.
Specify your facebook APl key and locale.

¢ ‘Yes, Allow Disqus Comments’ to enable disqus comment on store view page. Specify
your disqus forum shortname.

¢ ‘Yes, Allow Google Comments’ to enable google comment on store view page.

R
Service APl and Comments
R
Google Map API key
d Flease enter your Google Map API key. Follow this guide to Get
your APl key
R
Allow Comment | Yes, Allow Google Comments -
~ Mo, Do not Alow Comment

Yes, Allow Facebook Comments

Store Search ves, Allow Disqus Comments

Save Config

®

©
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https://developers.google.com/maps/documentation/javascript/get-api-key

1.4. Store Search

Store Search Search Criteria — Choose the criteria to
search store in frontend. Customers
can search for stores by area using

Search Criteria | one Store Name, Country, State/Province,

store T City and Zip Code criteria.

Country

Default Radius for Search — Specify
the radius used with Google Suggest

State/ Province

to search nearest store from customer
location. Max radius is 2000.

City
Zip Code

Choose the Distance Unit :

¢ ‘Kilometers’ to measure distance
between store and customer in
kilometer.

e ‘Miles’ to measure distance

Select criteria to search for store in frontend. between store and customer in miles

Default Radius fu_nr 5earcr] 100

' Used with Google Suggest to search nearest store from customer
location. Max raidus is 2000.

[}iﬁta_nce Uni; Kilometers -

Unit to measure distance between store and customer.
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2. Store Locator Management

Stores
Reach features of the extension allow you to create stores adding store name, description, link, sort order, contact info, meta data, map
location, images, tags, schedule, holidays, special days and much more. To view, edit and create store, please go to Marketing - Store

Locator by Ulmod -» Stores. A convenient grid displays all your stores. Discover mass actions to manage stores content faster and export
them in CSV or XML file. To create new store, please click the 'Add New Store' button in the upper right corner of the page.

Tags
Tags are more specific. They help visitors find stores in the location they are interested in quicker. To view all the tags that are used in your

store location, please go to Marketing - Store Locator by Ulmod -> Tags. There you can view all the tags you have with their main
parameters on a convenient grid. Click on the tag to edit it and use the 'Add New Tag' button to create a new tag.

Schedules

Schedules help you provide the working time of your stores (from Monday to Sunday) to visitors. To view all the schedules that are used in
your store, please go to Marketing - Store Locator by Ulmod - Schedules There you can view all the schedules you have with their main
parameters on a convenient grid. Click on the schedule to edit it and use the 'Add New Schedule' button to create a new schedule.

Holidays

Holidays help you provide the holiday time of your stores to visitors. To view all the holidays that are used in your store, please go to
Marketing - Store Locator by Ulmod - Holidays, there you can view all the holidays you have with their main parameters on a convenient
grid. Click on the holiday to edit it and use the 'Add New Holiday' button to create a new holiday.

Special Days
Special days help you provide the special days of your stores to visitors. To view all the special days that are used in your store, please go to

Marketing - Store Locator by Ulmod - Special Days, there you can view all the special day you have with their main parameters on a
convenient grid. Click on the special day to edit it and use the 'Add New Special Day' button to create a new special day.
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2.1. Managing Stores

To create a new store, hit

the Add New Store
button.

Add New Store

Manage Store

Q W Filters > DefaultView ﬁ Columns - &, Export v
Actions - 2 records found (1 selected) 20 ¥ | per page 1 of 1
Enable
) Address i Zip Code Base Image | Status
Disable

Delete /ﬁ--" I, |
hir I-65, Mobile, A Maobile Alabama United States v 36606 ﬂ Enat | =

Edit
r S-72 A i 5 Celact -
2 Bridge Street s-72 ...LT. Huntsville Cancel m 35805 Enabled Select
Huntsville, AL

35805, USA

On this convenient grid , you can manage all your stores :
‘Add New Store’
‘Edit the existing ones or delete the stores you no longer need.’

‘ Mass enable/disable /delete/edit the selected stores’
Search store by keyword’

 Search store by filters’

“Export all stores in CSV or XML file’

lmod Page 13



2.1.1. Edit Store : General Information

Edit Store Bel Air ¢« Back Delete Reset Save and Continue Edit Save and New

STORE INFORMATION

Store Name - Specify

General Information the name of the

) ) store.
General information N
Store Name = | Bel Air
Description — Specify
Google Map Location . R
Description The Shoppes at Bel Air, formerly Bel Air Mall, is a super-regional shopping the brief description
:'Qéazllétl:ﬁ-iated in Mobile, Alabama, United States. The mall has a gross of the store to display
CAnE sl on store view (detail)
page.
Set Status option to ‘Yes’ to display
) P Status Enabled | =
the store in frontend or to ‘No’ to
do not display the store in
frontend. Store's Link demo.com
Store’s Link — Specify the store link Sort Order 0
or store’s website url to display on
view page.
Contact Information -

Sort Order — Specify the sort order
of the store on list page. Meta Information
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2.1.1. Edit Store : General Information

Edit Store Bel Air & Back Delete Reset save and Continue Edit Save and New m

Contact Information

Phone Mumber +1111 450-4393

Specify the store Phone Number,

EmaiIS address and Fax Number Email Address store’@gmail.com
to display on view page

Fax Number +1111 450-4396

Meta Information

URL Key - Specify the url key of URLKey | demostorel
the store

Meta Title Store 1
Meta Title - Specify the meta
title of the store

LA

&1

[=]
T

Meta Keywords

Meta Keywords - Write 4
keywords and phrases by which
visitors can find the store in
search engines.

LA
]

Meta Description

Meta Description - Add a brief
description of store.
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2.1.1. Edit Store : Google Map Location

Edit Store Bel Air

2 1URE INFUEMAITIUMN

Location Information

General information

Address +
Google Map Location City
Image Galler, i

Zip Code
Store's Schedule

Country

Store’s Tags

State/Province

Store's Holidays

Latitude

Store’s Special day
tore's Special days

Longitude +

Zoom Level +

Marker Icon - You can upload Marker Icon

an icon to use as store’s

marker on Google map instead
of the default pinicon.

lmod

<« Back Delete Reset

I-65, Mobile, AL 26606, USA

Mohile

36606

United States

Alabama

Choose file | Mo file chosen

Save and Continue Edit

Recommended size: 400x600 px. Supported format: jpg, jpeg g

Specify the store Address,
City, Zip Code, Country,
State/Province,

Latitude and Longitude - You do not

need to fill them out if you do not
remember your store’s coordinates.
If you pin a store directly from
Google map, these fields will be
filled automatically.

Zoom Level - It is used when
previewing the store’s location on
Google Map in backend and on the
Store Listing page in frontend. The
higher number you set, the higher
zoom-in level is
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2.1.1. Edit Store : Google Map Location

Edit Store Bel Air &« Back Delete Reset Save and Continue Edit Save and New

I-65, Mobile, AL 36606, USA m Reset Map

Fill your store’s address [65)
in this field or pin from Map  Satelite ~ @ BancorpSouth Branch e
the map, remember to corss© @ Taco geilgmy WA
click on the Save Store or

Save And Continue Edit

=1 Daur ol
S Ldudp =L VI, AL SRDUD, U oe

(=]
=]
[

[ I o T

button to save your

work. After that, store’s (5]
location will be updated :

automatically on Google

Radney Funeral
Home-Mohile

If the pin on the map is not

vap Mcbonsids o < in the right place, you can
L~ i : drag and drop it to where
5] ] you want to set a new
location
Go gle Mzp data 2017 Google  Terms of Use  Repart 2 map errar

o Click on map or drag the marker to set store position.
The information in popup will help you to get location information of your store in Google Map faster.
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2.1.1. Edit Store : Image Gallery

& Back Delete Reset Save and Continue Edit Save and New

Upload as many store images as you want. The base image will

STORE INFORMATION be shown in the store list.
Image Gallery

General information

Google Map Location '

Image Gallery

Store's Schedule

Store's Tags

Store's Holidays

Make Base

- -4
s R

Store's Special days
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Edit Store Bel Air

STORE INFORMATION

General information
Google Map Location
Image Gallery
Store's Schedule
Store's Tags

Store's Holidays

Store's Special days

@Imod

a

2.1.1. Edit Store : Store’s Schedule

< Back Delete Reset Save and Continue Edit

Choose a Schedule from a list to

apply for this store.

Time Schedule

Schedule Schedulel -

Click here to go to page create new schedule.

Monday Tuesday Wednesday Thursday
Status Open Open Open Open
Open Time 08:16 00:00 00:00 00:00
Open Break Time 15:16 00:00 00:00 00:00
Close Break Time 15:16 00:00 00:00 00:00
Close Time 15:16 00:00 00:00 00:00

Friday

Cpen

00:00

00:00

00:00

00:00

Saturday

Cpen

00:00

00:00

00:00

00:00

Sunday

Open

00:00

00:00

00:00

00:00
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2.1.1. Edit Store : Store’s Tags

Edit Store Bel Air € Back Delete Reset Save and Continue Edit Save and New

STORE INFORMATION
m Reset Filter 1 records found 20 v | per page 1 of 1

General information

Tag ID } | Tag Name Description Icon Action
Google Map Location  # Yes |
mage Gallery
2 tag2 tag2 Edit
v g g

Store's Schedule

Store's Tags

Store's Holidays Choose a tag to apply for this store.

Store's Special days The tags will display on store list pages, helping visitors find
stores in the location they are interested in quicker.
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2.1.1. Edit Store : Store’s Holidays

Edit Store Bel Air

<« Back Delete Reset Save and Continue Edit Save and New
m Reset Filter 2 records found 20

Holiday ID 4 | Holiday Name Date Start

STORE INFORMATION

v | per page 1 of 1
General information

Date End Comment

Google Map Location #

mage Gallery

v 1 Haoliday1 Dec 1, 2016 Dec 20, 2016 Christmas Holiday Edit
Store's Schedule

o 2 Holiday2 Oct 29, 2016 Oct 31, 2016 Mew year Edit
Store's Tags -
Store's Holidays

Choose a holidays to apply for this store.

Store's Special days

The holidays will display on store view page, providing
visitors with the holiday time of your store.

lmod
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2.1.1. Edit Store : Store’s Special days

Edit Store Bel Air & Back Delete Reset Save and Continue Edit Save and New

STORE INFORMATION

m Reset Filter 1 records found 20 v | per page 1 of 1

Special day

General information

— Date Start Date End Open Time Close Time Comment Action

Google Map Location

Image Gallery
= Special dayl @ Mov 1, 2016 Mov 2, 2016 07:16 18:06 Special dayl Edit

Store's Schedule
Store's Tags
Store's Holidays

Choose a special days to apply for this store.

Store’s Special days

The special days will display on store view page,
providing visitors with the special days of your store.
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2.2. Managing Tags

To create a new tag, hit
the Add New Tag button.

20

-

per page

-ﬁ Columns

Add New Tag

*
[P ]

Export -

of 1

Manage Tag
Q W Filters
Actions - 2 records found (1 selected)
Delete
Description
Edit
v

lmod

tagl tagl

On this convenient grid , you can manage all your tags:
e ‘Add New Tag’

e ‘Edit the existing ones or delete the tags you no longer need.’

‘Mass delete/edit the selected tags’
* Search tag by keyword’

‘Search tag by filters’

“Export all tags in CSV or XML file’
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2.2.1. Edit Tag : General Information

Edit Tag tag'] ¢« Back Delete Reset Save and Continue Edit Save and New

TAG INFORMATION Tag Name — Specify
General Information the name of the tag.

General information Tag Name =+ | tagl Description - Specify
a brief description of

Stores of Ta

% Description tag’ the tag.
Icon — upload the tag
Icon to display on
store listing page.
Icon Choose File | No file chosen
Recommended size: 400x600 px. Supported format: jpg, jpeg, gif, png.
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2.2.1. Edit Tag : Stores of Tag

Fdit Tag tag'] €« Back Delete Reset Save and Continue Edit Save and New

TAG INFORMATION

m Reset Filter 1 records found 20 * | perpage 1 of 1

Address i State Zip Code | Status Action

General information

Stores of Tag

2 Bridge US-72 ALT, Huntsville | Alabama United States 35805 Enabled | Edit
L Strest Huntsville,
AL 35805,
USA

Choose the stores to which tag will be applied.

The tags will display on store list pages, helping visitors find
stores in the location they are interested in quicker.
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2.3. Managing Schedules

To create a new schedule, hit

the Add New Schedule button.

Manage Schedule

Add New Schedule

Q W Filters > DefaultView - 'n' Columns - M Export
Actions - 2 records found (1 selected) 20 ¥ | per page 1 of 1
Delete
Wednesday Thursday . Saturday
Edit Status Status Friday Status | o s
v 1 Schedulel Cper | = Cper | = Open v Open | = Opel | = Open | = Opel | =

Open Close Close Select =

On this convenient grid , you can manage all your stores schedules:
e ‘Add New Schedule’
‘Edit the existing ones or delete the schedules you no longer need.’

‘Mass delete/edit the selected schedules’
*Search schedule by keyword’

* Search schedule by filters’

“Export all schedules in CSV or XML file’

lmod Page 23



2.3.1. Edit Schedule : General Information

€ Back Delete Reset Save and Continue Edit Save and New Save Schedule

SCHEDULE INFORMATION
General Information

General information schedule Name + | Schedulet Schedule Name - SpeCIfy the
schedule name

Stores of Schedule
Monday Apply to all

Monday Status * |Open | =

Hit ‘Apply to all ‘ to auto apply
the same schedule in all the rest
of days

For each day ( Monday, Tuesday,
Wednesday, Thursday, Friday, Saturday OpenTime x [08 | ¥ |:|16 | ¥
and Sunday) specify :

* ‘Status’ Open or Close openpreskrme » &I 1B

e ‘Open Time’ the time store will be Close Break Time = |15 Te:[16 v

open during the day.

e ‘Open Break Time’ the time store CloseTime = |15 | v ;16 | ~

start a break during the day.

¢ ‘Close Break Time’ the time store Tuesday

finish a break during the day. Wednesday Define the schedule

¢ ‘Close Time’ the time store is closed details for the rest of
during the day. Thursday days or Hit the ‘Apply

to all “ button to auto
apply the same

Saturday Monday settings to
the rest of days

Friday

Sunday
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2.3.1. Edit Schedule : Stores of Schedule

<« Back Delete Reset Save and Continue Edit Save and New Save Schedule

m Reset Filter 1 records found 20 v | perpage 1 of 1

Address City Zip Code Status Action

SCHEDULE INFORMATION

General information

Stores of Schedule

1 Bel Air [-65, Maobile Alabama United States 36606 Enabled Edit
Maohile, AL
36606,
JsA

Choose the stores to which schedule will be applied.

The schedules will display on store view pages.
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2.4. Managing Holidays

To create a new store holiday, hit the

Add New Holiday button.

Manage Holiday

Q W Filters € DefaultvView ﬁ Columns - ot Export w
Actions - 2 records found (1 selected) 20 ¥ | per page 1 of 1
Delete
Date Start Date End Comment
Edit
v Holiday1 01/20/2016 01/20/2016 Christmas Holiday

{29/2 B 6 V3 Select =
2 Holiday2 10/29/2016 Cancel m 16 New year C

On this convenient grid , you can manage all your stores holidays:
e ‘Add New Holiday’
e ‘Edit the existing ones or delete the holidays you no longer need.’

‘Mass delete/edit the selected holidays’
“Search holiday by keyword’

“ Search holiday by filters’

“Export all holidays in CSV or XML file’
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2.4.1. Edit Holiday : General Information

< Back Delete Reset

HOLIDAY INFORMATION
General Information

General information

Holiday Name + | Holiday1
Stores of Holiday
Date Start * | 12/1/1¢
Date End * | 12/20/16
Comment Christmas Holiday

lmod

Save and Continue Edit Save and New Save Holiday

Holiday Name — Specify the holiday
name

Date start — Choose the day, holiday
will start for a specified store.

Date end — Choose the day, holiday
will end for a specified store.

Comment — Specify a short comment
or description for holiday.
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HOLIDAY INFORMATION

General information

stores of Holiday

@Imod

2.4.1. Edit Holiday : Stores of Holiday

< Back

Delete

m Reset Filter

Store
1D
Yes A
1
'
2
"

i

Store
Name

Bel Air

Bridge
Street

2 records found 20 v

Reset Save and Continue Edit Save and New

per page

Address

Zip Code

I-6%, Mobile, Maobile Alabama United States 36606
AL 36606,
LS4
Us-72 ALT, Huntsville Alabama United States 35805
Huntsville,

AL 35805,

UsA

Choose the stores to which holidays will be applied.

The holidays will display on store view pages.

Save Holiday

Status

Enabled Edit

Enabled Edit
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2.5. Managing Special Days

Manage SpECiEﬂ day To create a new store special day, hit D L mrdemo v

Add New Special day

the Add New Special day button.

Q W Filters > DefaultView - ﬁ Columns I, Export -
Actions - 1 records found (1 selected) 20 ¥ | per page 1 of 1
Delete
Special day Name Date Start Date End Open Time Close Time Comment Action
Edit
V1 special day? 01/20/2016 01/20/2016 07:16 18:06 Special day”

On this convenient grid , you can manage all your stores special days:
e ‘Add New Special day’
e ‘Edit the existing ones or delete the special days you no longer need.’

‘Mass delete/edit the selected special days’
 Search special days by keyword’

“Search special days by filters’

“Export all special days in CSV or XML file’
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2.5.1. Edit Special Day : General Information

Edit Special day Special day1

&« Back Delete Reset Save and Continue Edit Save and New Save Special day

General Information

Special day Name — Specify the

General information

Special day Name = | Special day1 .
special day name
Stores of Special day - -
Date Start = Date start — Choose the date, special
day will start for a specified store.
Date End = 11/2/16
Date end — Choose the date, special
opentime |07 % :[10 i day will end for a specified store.
Open Time — Specify the time , special
Close Time S O K R day will start for a specified store.
Comment | Special day] Open Close — Specify the time,

special day will end for a specified
store.

Comment — Specify a short comment
or description for the special day.
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SPECIAL DAY INFORMATION

General information

stores of Special day

@Imod

2.5.1. Edit Special Day : Stores of Special day

& Back Delete Reset Save and Continue Edit Save and New Save Special day

m Reset Filter 2 records found 20 v | perpage

Store
Name

Address i Zip Code

Yes - b
- Bel Air [-85, Mobile, Maobile Alzbama United States 36606
AL 36606,
LISA
o 2 Bridge US-72 ALT, Huntsville ; Alabama United States 35805
Street Huntsville,
AL 35805,

Choose the stores to which special days will be applied.

The special days will display on store view pages.

Enabled

Enabled
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3. Front-End View

Store Listing Page

Store listing feature allows visitors or customer to see all stores location in both map and list on same page.

Your stores are grouped on map within the same area and listed in left sidebar for better navigation. For each store,
you can add different icon to make it easily recognized or to separate stores on the map.

Store View Page
Store view page is a dedicated page to let customers Interact with your store easily. Everything customers need to

know about one store is shown directly on dedicated page.
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3.1. Store Listing Page : Search by distance

Store Locator

Customers can search
for stores either by

Q Searc

Define the location and radius in which you want to search

distance by defining
the location and radius

Alabama, United States

E All stores 2 Stores

Bel Air

I-65,

Store locations are
added to the _
locations list and .. Sr-ldge\it—'.'e:_r.r
displayed on the _
map.

lmod

472 Km

; ILLINOIS INDIANA 0HIO =]
Denver -
Map  Satelite o~ United States i o
L ap Kansas City Indianapalis MARYLA
An o o
COLORADO AR5 WEST o
0 KANSAS MISSOUR VIRGINIA Washingt
KENTUCKY VIRGINIA
Nashville
OKLAHOMA TeEn(®)sE T
& CAROLINA
ARKANSAS Charlotte
el MEW MEXICO Atlanta SOUTH
& 0 MISSISSIPPI 2 CAROLINA
Dallas
ALABAMA
Tucson i GEORGIA
Ja El Paso
~ \ TEXAS
™ Austin Jacksonville
SONORA \ 3 e LOUISTANA 6
P nt -3 o
CHIHL .".H.I\a\_\_\ j" N Saniantonia a New Orleans
s W, Orlando
o
COAHUIL -*.\\ Tagpa
\,
1 FLORIDA
\
NUEVO LEON :
Monterrey . S— . Miami
O o
AJA SINALOA ~
INIASUR DURANGO s
. TAMAULIPAS Bahamas
Mexico
Havana
@
SAN LUIS
NAYARIT POTOSI
Merida Cancun Cuba
Guadalajara_‘gyaNAJUATO o ; +
o
ALISC ATA
JALISCO Mexich City \.'r-‘f;cgfuaz YUCATAN S _
o a
coLima MICHOACAN o CAMPECHE “"'r';‘gf]"““ Talands.
Google PUEBLAZVERACRUZ TaBASCO /
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3.1. Store Listing Page : Search by area

What's Naw Women Men Gear Collactions Training Promotions Sale

Store Locator

Customers can search for stores by
(o e e Te—— Store name, State/Province, Zip Code,
Country, City

Search by Store name, State/Province, 2ip Code, Country, City
Beal Ar

Alabama

Tags

® o
gt ] sz

—
= All stores 1 Stores

rﬂq Bel A

1-65, Mobile, AL 24806, USA

Customers can also get
directions to each store

o
by entering a specific 0
location and clicking on
the Go button.

; , customers can see
= T e S A the real street that
. the store locates in
L i SO L by clicking on Street
Head northcon S Sth SttowardW 60 m T
oty View link

* 2 Tumnright at the 1stcross street 06km
onto W Liberty St

f* S Tumrightonto S 12t St 70Om

4. Slight leftio mergaento 165 S TOEM

toward Nashville

© 7017 Googhe  Tawnis of Lies | Regert & probies
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3.2. Store View Page

Customers can see store name,

description and easily go back on

Bel Air store list

The Shoppes at Bel Air, formerly Bel Air Mall, is a super-regional shopping mall, located in Mobile, Alabama, United States. The mallhasa g

€ store Infomation " Map satelite
O'Charley’s
= Restaurant & Bar
Address: 1-53, Mobile, AL 36606, USA Mobile Alabama United ® p =
ol

Phone: +1111 450-4393
Fax: +1111 450-4396 ' “g"”t
Email: store1@gmail.com

Link: demao.com Drury It

D
2]

o
65, Mobile, AL 36606, USA Customers can see store
information and easily get the
directions to a store
(O] Opening hours
Sun: Closed : H__”W"'L”'“."”&
Suites Mobiles -65

Mon:

Tue ,

e Customers can see store’s

. schedules or opening hours

Fri Closed

53 Closed

Google

lmod

: Link: demo.com

ross leasable

Bel Air
Address: -6, Mabile, £
Pheone: +1771 430

o Si

REELC

@ oillard's

Fax: =71177 450

Email: store 1 @amail.com
Fo

Perfect Nailso
@ Maurices
AutoMNation Ford Mohilea
554
55/
+
Map data ©2016 Google Terms of Use Report a map error
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3.2. Store View Page

Bel Air

The Shoppes at Bel Air, formerly Bel Air Mall, is a super-regional shopping mall, located in Mohbile, Alabama, United States. The mall has a gross leasable

Springdale Mall ©

Customers can also view location

o a details marked on the map by a
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and interests
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3. Support

Need Help?
Ulmod Support team is always ready to assist you, no matter which part of the world you are in. If something does

happen and you think you might be experiencing an issue or bug, please contact us via support@ulmod.com and we
will help you out.

Got Questions ?
Should you have any questions or feature suggestions, please contact us at: http://ulmod.com/contact/
Your feedback is absolutely welcome!
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